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Introduction to RPM 

Welcome to Rental Property Manager 
Rental Property Manager (RPM) is a one-stop database for managing your rental 
property information. RPM is designed by a property manager to meet your unique 
needs. It is for real estate professionals and private property investors alike.  

Using RPM, you can save and manage data about your properties, tenants, and 
financial transactions. RPM includes advanced reporting functions that create 
spreadsheets with the rental information you need. 

Is your property portfolio residential, commercial, rural, or varied? Do you have two 
or three properties, or two or three hundred? RPM can grow with your portfolio. It 
provides the following functions: 

• Manage data about every property, including: 

• Complete data 

• Specific notes, including a property log and photographs 

• Detailed, customizable lists of assets and property dimensions 

• Full Inspection records, including digital photos of your property 

• Manage data about your tenants, including: 

• Detailed tenant and tenancy data, including scans and images 

• Link tenants to properties 

• View tenants' current rent, amount owing, and upcoming payments 

• Record and report on financial data for your properties, including:  

• Income 

• Expenditures 

• Automatic Calculate Rents function provides fast updates of who owes you 
rent 

• RPM Planner provides an event calendar for scheduling property inspections 
and other events 

• RPM Contacts now provides details of non-tenant contacts - record cleaners, 
builders, local councils, and other service providers 

• Create reports with practical information about your properties, tenants, 
assets, expenditures, and more 

Some people may be using the trial version of Rental Property Manager. The trial 
version will only provide functions for 30 days. Ordering a full license takes care of 
this and gives you full functionality, providing you with official tech support. It’s a 
small investment to help you manage your larger ones.  
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Whatʹs New in RPM 2 
Here is important and useful new functionality we have developed for Rental 
Property Manager 2. Users can now access and benefit from the following: 

Property and Tenants 
• Tenant data now uses Active/Inactive rather than tenancy end date  

• Contacts for properties, tenants, etc. 

• Send emails to Contacts and Tenants  

• Add and edit Photos for Properties, Tenants and Contacts  

• Event logs for Properties, Tenants and Contacts  

• Tenant Details report  

Financial Data 
• Enter recurring income and expenses 

• Customisable list of default fees  

• Create late fees 

• Create custom fees 

• Pro rate initial rent  

• Add income, monies due, or payments 

• Customisable Income categories with taxable/Non taxable sections  

• Customisable Expense categories with depreciable/non depreciable sections  

• Mark multiple tenants as paid  

• Invoices and receipts now show the current balance outstanding  

• All financial reports use taxable/depreciable categories  

• All financial reports ask for a date range  

• Rents now calculate one rent period into the future  

• Note chargeable expenses 

General Improvements 
• Password protection for databases 

• Database is now faster and more robust  

• User interface is redesigned 

• Search/Filter functions are simplified 

• Users can create more custom fields 

Reports 
• Multiple new reports  

• Report editing is easier and more comprehensive 

• Reports can now be exported to the following formats and more: PDF, HTML, 
Excel files, and emails.  
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Terms Used in RPM 
The following list is real estate terms and how they are used in RPM. 

Asset An item, appliance, or space (such as parking) that adds to a 
property's value. 

Contact A person or business, not a Tenant, who is involved with your 
properties. 

Database A group of linked files that saves your RPM information.  

Dimension A space within or related to the property, such as a room, an 
office, a deck, or a garage.  

Event Something related to a property that is noted to take place on a 
certain date and time. RPM can list events and give you 
reminders about events. 

Expense A cost or payment for an item or repair related to a property.  

Income Rent or other money paid by a Tenant for the use or occupation 
of a Property. 

Inspection The act of reviewing a property's physical condition before or 
after a tenant occupies the property. 

Invoice A document informing a person of payments due or in arrears. 

Logs Detailed records of activities with a tenant, property, or contact. 

Property A building or space that you own and rent or lease to Tenants. 

Receipt A document confirming that a person has made a payment to 
you. 

Recurring An expense or income payment that repeats on a regular basis. 

Rent Money paid by Tenants for renting or leasing a property. 

Rent Rate The amount of money to be paid in rent for each Rent Period. 

Rent 
Period 

The increments of time for which rent is to be paid, i.e., weekly, 
monthly. 

Report An RPM Report lists specific data as a reference for you.  

Tenant A person who is renting your property, or a space or unit within 
your property.  
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Getting Started in RPM 

Setting Up and Using RPM for New Users 
Are you setting up RPM for the first time? Enter your data into RPM in the order 
below. 

1. The first thing you need to do is create a database. This provides a foundation 
for saving your Property data. 

2. Once you have set up a Database, review the Options. Make changes to the 
Options to meet your requirements. 

3. Once the Options are set up to meet your needs, you can enter Property data. 
Your information about tenants, income, and expenditures are all linked to 
Properties. It is helpful to collect all your Property data before you begin data 
entry.  

4. Enter the main Property details, then note Property assets, dimensions, and 
inspection results and photographs.  

5. Now you can add Tenants, Expenses, Contacts, and Income, and use the 
Reports. The Reports increase in value the more you use RPM. 

Take some time every day, week, or month to update your RPM data. Use the 
Planner to schedule events, and Contacts to keep track of your service providers. 
Back up your databases. 

 

RPM is as intelligent and useful as you make it - use your software investment to get 
the most out of your property investment.  
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Setting Up Default Options  
Before you start to use RPM, you should set up Options. Options provide customized 
data for you to select when you create Properties, Planners, Assets, Dimensions, and 
Categories. The values you enter here appear in drop-down menus for you. In 
addition, Options also enable default functions, especially regarding rent payments 
and overdue notices. 

 

Instructions 
1. In the Tools menu, click Options. 

2. The Options screen displays. 

3. There are value tabs in the Options screen. To open a tab, click on its name in 
the Options screen sidebar. In each tab, you can set up RPM option values for 
the following areas. Click the item to view the Options values: 

• General 

• Planner 

• Custom Fields 

• Asset Categories 

• Dimension Categories 

• Inspection Categories 

• Other Categories 

• Invoice Layout 

• Receipt Layout 

• Default Fees 

4. Enter data into the data fields. For some items, you may need to select a 
related Category, or click a check box to activate or deactivate an option. See 
the table below for definitions of the Options values. 

5. For the Asset, Dimension, Inspection Category, and Other Category tabs, you 

can enter and delete items. Use the Add Category button  to add a new 

category. Use the Delete Category button to delete a category. For 

items in a category, use the Add Item   and Delete Item buttons. 

6. When you have finished entering the values you need, click OK. 

7. The Options will be applied throughout RPM and are available for your use. 
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Options Screen Values 

General Tab 

Calculate 
rent on 
startup 

Check this box to have RPM perform this function. 

Calculate 
rent in 
advance 

Enter the number of days that RPM should use in advance rent 
calculations. 

Flag tenant 
when 
overdue  

Check this box to have RPM notify you when a tenant's payments are 
overdue. 

Display 
usage tips  

Check this box to have RPM display useful help tip messages 
automatically. 

Reset Tips 
button 

The tip messages rotate from 1 to 100. To start the messages 
displaying at message 1, click this button. 

Show text 
on Toolbar 
buttons 

Check this box to include text on toolbar buttons. If this is not 
checked, the toolbar buttons only display icons. 

Defaults This frame contains default values that are applied throughout RPM. 

Rent 
Payment 
Period 

Select a rent payment frequency from the drop-down menu. This will 
be applied as the default rent payment frequency for all new 
Tenants. 

Rent 
payments 
in advance 

Select a number for the standard weeks of rent in advance that you 
want as the default advance payment from Tenants. 

Rent rate Enter an average rent rate. This value is not required. Managers with 
many similar units may find this useful.  

Financial 
Year 

This frame contains the default value for entering the start date of 
your Financial Year.  

Planner 

Show rent 
due dates 
in Planner 

Check this box to display the dates when rents are due in the 
Planner. 

Show rent 
due alarms 

Check this box to display alarms for overdue rent. 

Show 
unpaid rent 
alarms 

Check this box to display alarms for rent that has not been paid. 

Show Enter the number of days after which alarms for unpaid rent will 
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alarm after 
X days. 

display. 

Show rent 
reviews in 
Planner 

Check this box to display when rents should be reviewed in the 
Planner. 
 

Show rent 
review 
alarms 

Check this box to display alarms indicating that it is time to review 
rents. 

First 
review due 
after 

Enter the number of weeks that will pass before the first rent review. 

Show 
inspections 
due in 
Planner 

Check this box to display when inspections are due for properties in 
the Planner. 

Show 
inspection 
alarms 

Check this box to display alarms for overdue inspections. 

Inspection 
due every 

Enter the number of weeks that will pass between inspections. A 
year is 52 weeks; six months is 26 weeks. 

Show 
tenancy 
end dates 
in Planner 

Check this box to display when tenancies are due to end in the 
Planner. 

Show 
tenancy 
end alarms 

Check this box to display alarms for tenancies reaching their end. 

Custom Fields - See the instructions for Creating Custom Fields. 

Asset Categories 

Category Enter a general category of property Assets. Examples include: 
• Furnishing 
• Appliances 
• Parking 

Asset for 
Category 
 

Select an Asset Category from the drop-down menu, then enter 
specific assets for that Category. For example, for the asset 
Appliances, enter Dishwasher, Washing Machine, Dryer, Refrigerator, 
etc. If the asset will depreciate in value, check the Depreciable box. 

Dimension Categories 

Category Enter a general category for property Dimensions. Examples include: 

• Bedroom 

• Kitchen 

• Bathroom 

Asset for Select a Dimension Category from the drop-down menu, then enter 
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category specific dimensions for that Category. For example, for the 
dimension Bedroom, enter Floors, Walls, Windows, Wardrobes, etc. 

Inspection Categories 

Category Enter a general category of Inspection category and Category Type. 
Items entered here will be used against properties being inspected. 
Examples include: 

• Bedroom 1 - type: Bedroom 
• Bathroom 1 - type: Bathroom 
• Parking Area - type: Outdoors 

Category 
Type 

 

Select an Inspection Category from the drop-down menu, then enter 
specific inspection items for that Category. For example, for the 
category Bedroom, note for inspection Closets, Light Fixtures, Walls, 
Windows, Floor, etc.  

Other Categories 

Section Select the Section where you want to add the new category: 
Contacts, Income, Expense, or Notes. 

Category  To enter a new Category, click Add and then type the new Category 
name in this field. 

Category 
List 

This list shows all the active Categories for this Section.  
For Income and Expense, check the box if a category item is Taxable 
or Deductible. 
To delete a category, select it and click the Delete button. 

Invoice Layout - see the instructions for Invoice and Receipt Layout. 

Receipt Layout - see the instructions for Invoice and Receipt Layout. 

Default Fees 

Late Fees Late Fees are normally applied to late tenant rental payments. 
Each Late Fee has the following values: 

• Fee Type - Type of fee: daily, once only, or no fee. 
• Fee Amount - The amount of the fee. 
• Day Due - Enter the number of days after the original 

payment is due when this late fee is applied. 

Custom 
Fees 

To enter a new Custom Fee category, click Add and then type the 
new custom fee name. 
Each Custom Fee has the following values: 

• Name - Name of the Custom Fee. 
• Category - Select a fee category from the drop-down menu. 
• Fee - Fee amount. 
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Creating Custom Fields 
You may want customized data categories to be included in your records. In RPM, 
you can create a limited number of customized data fields for your data. This is done 
from the Options screen, using the instructions below. 

You can create text fields for word-based data, or number fields for numerical data. 

 

Instructions 
1. In the Tools menu, click Options. 

2. The Options screen displays. 

3. Click on the Custom Fields tab.  

4. Select the data category for the Custom Field by selecting it from the Section 
drop-down menu. The options are: 

• Contact 

• Expense 

• Income 

• Inspection 

• Property 

• Tenant 

5. Any custom fields you create will be added to the selected Section. 

6. To activate a custom field, do the following: 

• For a text field, check one of the Show boxes to activate the custom item. 
Then enter the name of the field. 

• For a number field, check one of the Show boxes to activate the custom item. 
Then enter the name of the field. 

• Click OK.  

5. The text and number fields you have added are activated in the specified 
Sections. They become active both in the item details for all items, and in the 
main screen grid display of the items.  
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Invoice and Receipt Layout 
You can use RPM to generate invoices and receipts for your rentals. You can 
customize the text in the RPM generated invoices and receipts, using the Invoice 
Layout and Receipt Layout options.  

An example of an RPM receipt is the following: 

 

Instructions  
1. In the Tools menu, click Options. 

2. The Options screen displays. 

3. Click on the Invoice Layout or the Receipt Layout tab.  

4. You can enter and format additional invoice text. This text will be used for all 
invoices/receipts. You can enter and format text to appear in the following 
locations: 

• Top Left 

• Top Center 

• Top Right 

• Footer 

You can also format the official Title of the invoice/receipt. 

5. To view an example of the invoice/receipt, click the Preview button. A 
Preview of the document displays.  

6. If the Preview is suitable, click Close. You are returned to the Options 
screen. 

7. Click OK. Your changes are saved. The format you have entered will be used 
for Invoices or Receipts. 
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The Recycle Bin and Deleted Data 

To delete data in RPM, select a data item and click the Delete button . 

The item is then deleted from the data screen and saved in the Recycle Bin. 

The item stays in the Recycle Bin until you choose to delete it permanently, or to 
restore it. Restoring it replaces the item in the main database; it is "undeleted." 

 

Restore Items 

1. To restore a deleted item, open the Recycle Bin . 

2. Select the item by clicking on its row. Select multiple items by clicking each 
one in its check box. OR, select All Items by clicking the Select All button 

.  

3. Click Restore Selected . The selected item is removed from the 
Recycle Bin and returned to the main database. 

 

Delete Items Permanently 

1. To delete an item permanently, open the  Recycle Bin . 

2. Select the item by clicking on its row. Select multiple items by clicking each 
one in its check box. OR, select All Items by clicking the Select All button 

.  

3. Click Delete Selected . The item is permanently deleted. 
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Navigation in RPM 
RPM is easy to navigate. Its graphic user interface displays your property data 
clearly. To learn more about the areas of the RPM screens, review each of the 
following topics: 

• Menus – see page 14 

• Toolbars are described in each screen description. There is a Filter Toolbar 
that can be activated for all screens – see page 16. 

• Screen Summary - review of all screens in RPM and their uses – see page 15 

• Specific Screen Details are available for major screens: 

• Property Screen – page 17 

• Tenant Screen – page 31 

• Income Screen – page 36 

• Expenses Screen – page 42 

• Inspections Screen – page 28 

• Contacts Screen – page 44 

• Planner – page 47 

• Reports – page 51 
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Menus in RPM 
RPM has a simple user interface. The Menus provide links to all screens and functions 
in RPM. Each Menu is shown below, with a list of its associated functions. 

 

File Menu 
Database Functions - see About Databases 
for a review of all functions. 

Recent Items - Review a list of recently 
used databases. 

Exit - Closes RPM. 

 

 

Add Menu 
Click on each Section to add a new item to 
that section. See Screens in RPM for 
details. 

 

View Menu 
Click on each Section to view the related 
screen or Toolbars. See Screens in RPM 
and Search and Filter Data Screens for 
details. 

 

Tools Menu 
Edit Report - Enables you to select and edit 
a Report. 

Calculate Rents - Instantly calculates rents 
owed and due. 

Options - Opens Options for editing. 

 

 

Help Menu 
Contents - Opens online help. 

Buy Now - Link to the RPM purchase page. 

Show Welcome Screen - Displays the RPM 
Welcome screen. 

About - Opens your RPM user details, 
including the Version Number. 
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Screens in RPM 
There are eight major function screens in RPM. These screens provide access to 
tasks and data for their function area. The main display includes a sidebar with 
buttons and the Menu bar. Move from one function screen to another by clicking the 
screen buttons, or use the View menu. 

Each screen includes a Toolbar, with buttons for tasks, and one or more data tables. 

HINT: The data tables in each screen can be sorted. Click on a column header to 
sort the table by the data in that column. 

  
Tenants Screen 

The Tenants screen is your center for Tenant data. The main data table lists 
the Tenants. When you select a  Tenant, the information tabs at the bottom of 
the screen display that Tenant's data. 

Properties Screen 
The Properties screen is your center for property data. This is the default 
screen, and it provides access to all the major functions in RPM. The main data 
table lists the Properties. When you select a  Tenant, the information tabs at 
the bottom of the screen display that Property's data. 

Income Screen 
The Income screen lists all received Income for all properties or a selected 
property. The bottom of the page has an Income total, summarizing Income 
due and Income paid. 

Expenses Screen 
The Expenses screen lists all Expenses for all properties or a selected property. 
The bottom of the page has an Expenses total. 

Contacts Screen 
The Contacts screen lists all the non-tenant Contacts you work with regarding 
your properties and rentals. When you select a Contact, the information tabs at 
the bottom of the screen display that Contact's data. 

Planner Screen 
The Planner provides a calendar where you can list visits and events relating to 
your properties and to your property maintenance. Set recurring events and 
event reminders, and view your property time commitments at a glance. 

Inspections Screen 
The Inspections screen lists inspections for properties. The main data table lists 
completed inspections. 

Recycle Bin Screen 
The Recycle Bin screen saves all RPM data that has been Deleted. Restore or 
finalize data deletion from this screen. 

Reports Viewer 
The Reports Viewer displays when you select a Report. It includes the 
requested Report and navigation tools for the report. 
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Search and Filter Data Screens 
When you have many records, you may need to search them. To do this, you can 
use the Filter Toolbar. 

In all screens, you can filter on data columns, and even create a custom filter for a 
data column.  

View the Filter Toolbar 
1. The Filter Toolbar always displays at the top of each screen. 

 
2. To do a simple Search, type a word or number in the Filter field. Or, select 

an item automatically from the drop-down menu of data.   

 
4. RPM will highlight all the records on a screen that include the term or the 

selected search item. 

  
Filter on Columns 

1. Open the Screen. 

2. Hover over the column that you want to search. Click the icon that appears. 

3. The Column Filter list for that column displays. 

 
4. Check on each value that you want to view. 

5. The screen displays only the values you have selected. 

6. To return to the standard view, open the Column Filter list and click All. All 
the values available display once again. 

 

Create a Custom Filter 
You can create a custom filter for a specific column of data in a Screen. 

1. Open the Screen where you want to include a custom filter. 

2. In the Column Filter list, select Custom. 

3. The Custom Filter screen displays. 

4. From this screen, you can set up a Boolean search for the data in that 
column. Use the values, plus the and/or options. 

5. Click OK. 

6. The custom filter you have created for that column of data will display in the 
Column Filter list. 
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Manage Property Data 

The Property Screen 
The Property Screen is your center for property data. This is the default screen, and 
it provides access to all the major functions in RPM.  

From this page, you can do the following: 

• Add or Edit a Property 

• Add or Edit a Tenant  

• Add or Edit Property Notes or Edit a Property Event Log 

• Add or Edit Contacts 

• Add or Change Property Photographs 

• Add or Edit Expenses 

• Add or Edit Income from a Property 

• Add or Edit Property Assets 

• Add or Edit Property Dimensions 

• Delete a Property 

• Use the Calculate Rents Function 

• View Property reports: 

• Tenant List Report 

• Rent Outstanding Report 

• Property and Tenant Lists 

• Income & Expenses Report 

• Income Report 

• Expenses Report 

• Asset List Report 

• Dimensions Report 

To access functions, use the Property Toolbar. 

 
The main data table lists the Properties. To sort the Property list, click on a column 
item in the Property table heading. The Property list will be sorted based on that 
column.  

Selecting a Property displays information for that Property at the bottom of the page. 
This includes Tenants, Contacts, Photos, and Logs. You must select a property to add 
data to that property. 
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Add or Edit a Property 
You can add or edit data about Properties. A Property is a building or space that you 
own and rent or lease to Tenants.  

 

Add a New Property 
1. To add a new Property, go to the Properties screen. 

2. Click on the Add Property  button. 

3. The Property Details screen displays.  

4. Complete the Property Data by typing or selecting the information into each 
field. 

5. If a data field is yellow, that data is required for the property record. If a data 
field is white, that data is optional. 

6. When all the data required/available is entered, click OK.  

7. The Property data is saved. The Property displays in the Property screen. You 
can now assign Assets, Dimensions, and Tenants to the Property.  

 

Edit a Property  

1. To Edit a property, go to the Properties screen . 

2. Find and select the Property in the Property list. 

3. Click the Edit Property button . 

4. The Property Details screen displays. 

5. Edit the details, then click OK. The changed Property data is saved.  

  
Property Details Screen Values 

• Name - Reference name for the property. 

• Address - Complete street address of the property. 

• No. Units - Number of units (apartments, flats, townhouses, offices, etc.) at 
a property location. 

• Notes - Enter any notes about the Property. 

• Purchase Date - Date when the Property was purchased. 

• Value - The value of the Property. 

• Mortgage - The outstanding mortgage on the Property. 

• Date Sold - The date when the Property was sold, if it was sold.  

• Sale Price - The sale price received for the Property, if it has been sold.  
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Add or Edit a Tenant 
You can add or edit data about Tenants. A Tenant is the person who is renting your 
property, or a space or unit within your property.  

 

Add a New Tenant 
1. To add a new Tenant, go to the Properties or Tenants screen. 

2. Click on the Add Tenant button. 

3. The Tenant Details screen displays.  

4. Complete the Tenant Data by typing or selecting the information into each 
field. 

5. If a data field is yellow, that data is required for the tenant record. If a data 
field is white, that data is optional. 

6. When all the data required/available is entered, click OK.  

7. The Tenant data is saved. The Tenant is now assigned to the specified 
Property, and displays in the Tenant screen. 

 

Edit a Tenant 
1. To Edit a tenant, go to the Tenant screen . 

2. Find and select the Tenant in the Tenant list. 

3. Click the Edit Tenant button . 

4. The Tenant Details screen displays. 

5. Edit the details, then click OK. The changed Tenant data is saved.  

  
Tenant Details Screen Values 
TENANT details 

• Last Name 

• First Name 

• Title 

• Email 

• Mobile Phone 

• Home Phone  

• Work Phone 

• Contact Address 

• Notes - Enter any notes about the Tenant.  

• Reference Details - Enter any people providing character references for the 
Tenant. 

PROPERTY details for the Tenant 
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• Property - Select the Property name from your list of entered Properties. 

• Unit - Note which Unit at the Property the Tenant is renting. 

• Tenancy Start - Date of the tenancy start period, as noted on their lease. 

• Tenancy End - Date when the tenancy ended. 

• Active - Check this box if this tenancy is still ongoing. 

• Rent Period - Amount of time for which the tenant pays rent; weekly, 
biweekly, or monthly. 

• Rent - Rent amount. 

• Rent Start Date - Date when the tenant's first rent payment was due. 

• First full rent period - The date when the first full rent period for the tenant 
begins. 

• Pro rate initial rent - Check this box if the first rent amount due was pro 
rated. 

• Payments in Advance - Amount of rent received in advance. 

• Deposit - Tenant's security deposit amount. 

• Deposit Returned Date - Date when security deposit was returned for 
former tenants. 

• Deposit Returned - Yes or No for former tenants. 
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Add or Edit Notes 
You can add or edit detailed text notes about Properties or Tenants. 

HINT: Consider whether your information is a Note or whether you need to record it 
as a formal event in the Event Log for the Property or Tenant.  

 

Instructions 
1. To add a new note, go to the Properties screen or the Tenants screen. 

2. Select the Property or Tenant for which you want to add a Note. 

3. Click on the Notes button . 

4. The Notes screen displays.  

5. Type in the note data. 

6. When all the note information is entered, click OK.  

7. The Note is now saved as part of the property or tenant data. 

 

 

Edit an Event Log 
You can add or edit event log entries about each Property or Tenant. 

HINT: Consider whether your information is a defined event, that needs its date 
recorded, or whether you need to record it as more general information in your 
 Notes.  

 

Instructions 
1. To add a new log entry, go to the Properties screen or the Tenants screen. 

2. Select the Property or Tenant for which you want to add a log entry. 

3. At the bottom of the screen, click on the Log tab. 

4. The Log screen tab displays.  

5. To enter a Log Event, right-click in the tab. A small menu displays. Select 
Add. 

6. A new row displays for your log event. The log event values are: 

• Date - Select the Date of the log event. 

• Category - From the drop-down menu, select the Category of the log 
event. 

• Comment - Enter any comments about the log event. 

7. When all the note information is entered, click OK.  

8. The log entry is now saved as part of the property. 

9. To delete a log entry, select the entry and right-click. A small menu displays. 
Select Delete. The log entry is deleted. 
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Add or Change Photos 
You can save and manage digital photographs with Property, Tenant, and Inspection 
files. Digital photos of your property provide a valuable reference, and are useful 
when advertising the property for rent. 

 

Instructions 
1. Before you begin, download the digital photos onto your computer. RPM must 

be able to locate these photos on your computer. 

2. Select the item to which you want to add photos. Click the Add Photo button 

. 

3. The Edit Photos screen displays for that item. 

4. Click Add Images . The Open screen displays. 

5. In the Open screen, locate the photo file on your computer. Select it. 

6. The photo opens in the Edit Photos screen.  

7. Add a caption to the photograph, noting its subject matter and the date when 
it was taken.  

8. Use the Back and Forward buttons  at the top of the screen to 
move through and edit photos you have already saved.  

9. Once you have added and edited all photographs, click OK. 

10. The photos display in the Photos tab of the Details for that item. 

11. You can edit a photo's caption by selecting it in the Photo Tab. Then, from the 

Add Photo button drop-down, click Edit Photo . In the Edit Photos 
screen, edit the caption, then click OK. 

12. Delete a photo by selecting it in the Photo Tab. Then, from the Add Photo 

button drop-down, click Delete Photo . In the Edit Photos screen, click 

Delete This Record . A message asks you to confirm this. Click Yes.  

13. The photo is deleted. Click OK. 

 

HINT: If you do not want a photo to display in the Property Inspection Report Form, 
uncheck the Show in Report? box in the Photo data screen. 
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Add or Edit Expenses 
You can add or edit data about Expenses assigned to properties. An Expense is a 
cost or payment for an item or repair related to a property. Note that you can also 
add or edit an expense as a Recurring Expense. 

 

Add a New Expense 
1. To add a new Expense, go to the Properties or the Expenses screen. 

2. Click on the Add Expense button . 

3. The Expense Details screen displays.  

4. Complete the Expense Data by typing or selecting the information into each 
field. 

5. If a data field is yellow, that data is required for the Expense record. If a data 
field is white, that data is optional. 

6. When all the data required/available is entered, click OK.  

7. The Expense data is saved. The Expense is assigned to the selected Property 
and displays in the Expense screen. It is also included in Reports.   

 

Edit an Expense 

1. To Edit an Expense, go to the Expenses screen . 

2. Find and select the Expense in the Expense list. 

3. Click the Edit Expense button . 

4. The Expense Details screen displays. 

5. Edit the details, then click OK. The changed Expense data is saved.  

  
Expense Details Screen Values 

• Property - Select the Property to which the Expense is linked. 

• Category - Select the category for the Expense. 

• Description - A brief description of the Expense. 

• Payee - Person or business receiving the Expense.  

• Amount - Amount of the Expense. 

• Date - Date when the Expense was paid. 

• Reference - Invoice number, check number, or other reference for the 
Expense. 

• Notes - Enter any notes about the Expense. 

• Charge to tenant - Check this box if this expense is to be charged to the 
Tenant at the Property. 
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Add or Edit Income from a Property 
You can add or edit data about Income paid by tenants. Income is rent or other 
money paid by a Tenant for the use or occupation of a Property. 

HINT: The Calculate Rents Function is a fast, easy way to add the most recent due 
rents to your list of Income due. 

 
Add a New Income Item 

1. To add a new Income item, go to the Properties or the Income screen. 

2. Click on the Add Income button . 

3. The Income Details screen displays.  

4. Complete the Income Data by typing or selecting the information into each 
field. 

5. If a data field is yellow, that data is required for the Income record. If a data 
field is white, that data is optional. 

6. When all the data required/available is entered, click OK.  

7. The Income data is saved. The Income is assigned to the selected Property 
and displays in the Income screen. It is also included in Reports.   

 

Edit an Income Item 

1. To Edit an Income item, go to the Income screen . 

2. Find and select the Income item in the Income list. 

3. Click the Edit Income button . 

4. The Income Details screen displays. 

5. Edit the details, then click OK. The changed Income data is saved.  

  
Income Details Screen Values 

• Tenant - Select the Tenant who paid the Income. 

• Category - Select the Category of income. 

• Date due - Select the date when the Income was due. 

• Date paid - Date when the Income was paid. 

• Rent - Amount of rent due from the Tenant for the Period. * Displays for New 
Income only. 

• Amount Paid - Amount of the Income paid. 

• Total Outstanding - Amount of Income still owed by the Tenant.* Displays 
for New Income only. 

• Reference - Invoice number, or other reference for the Income. 

• Notes - Enter any notes about the Income. 

• Late Fee - Select a late fee calculation option for this income. 
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Add or Edit Property Assets 
You can add or edit Assets to a Property. An Asset is an item, appliance, or space 
(such as parking) that adds to a property's value. Recording Asset details allows you 
to maintain the Asset (i.e., order spare parts), communicate with potential renters 
about all a property's benefits, and include the Asset in Inspection records. 

 

Instructions 
1. In the Property screen, select a Property. 

2. Click the Edit Assets button . 

3. The Edit Assets screen displays. 

4. From this screen, to add a new Asset category, click the Add Category 

button .  

5. To edit an Asset category, click the Edit Category button . The Edit field 
displays. Change the Asset category and click OK. 

6. To add a new Asset: 

• Select the category for the Asset in the left frame. 

• Click the Add Asset button . 

• The Asset Details screen displays. Enter the values. If a data field is 
yellow, that data is required for the record. If a data field is white, that 
data is optional. 

• The new Asset is added. 

7. Click OK to save all changes. 

 
Add Asset Screen Values 

• Asset  

• Name - Asset Name. 

• Details - Details of asset. 

• Notes - Notes about the Asset. As an example, for appliances, list 
serial numbers, warranty details, name and brand, etc. For fabric 
items, list fabric type and cleaning methods. 

• Purchase 

• Date Purchased  

• Purchase Price 
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Add or Edit Property Dimensions 
You can add or edit Dimensions of a Property. A Dimension is a space within or 
related to the property, such as a room, an office, a deck, or a garage. Dimension 
details are very important for maintenance, i.e., knowing how much carpet, paint, or 
other materials the property requires. Recording Dimension details allows you to 
maintain the Dimension, communicate with potential renters about all a property's 
benefits, and include the Dimension in Inspection records.  

 

Instructions 
1. In the Property screen, select a Property. 

2. Click the Edit Dimensions button . 

3. The Edit Dimensions screen displays. 

4. From this screen, to add a new Dimension category, click the Add Category 

button .  

5. To edit an Dimension category, click the Edit Category button . The Edit 
field displays. Change the Dimension category and click OK. 

6. To add a new Dimension: 

1. Select the category for the Dimension in the left frame. 

2. Click the Add Dimension button . 

3. The Dimension Details screen displays. Enter the values. If a data 
field is yellow, that data is required for the record. If a data field is 
white, that data is optional. 

4. The new Dimension is added. 

7. Click OK to save all changes. 

 
Add Dimension Screen Values 

• Name - Dimension Name. 

• Dimension - Measurements, area, etc. of Dimension item. 

• Notes - Notes about the Dimension item, i.e., unusual room shape. 
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Delete a Property 
Deleting a Property is simple. 

 

Instructions 
1. In the Property screen, select the Property you want to delete. 

2. Click the Delete Property button . 

3. A message displays, asking, "Do you want to send this record to the recycle 
bin?" Click Yes to delete. 

4. The property is deleted.  

5. Deleted property records go to the Recycle Bin.  

 

 

The Calculate Rents Function 
What does the Calculate Rents function do? It is an easy way to see who owes you 
rent, and how much, for the current rental period. Rents are calculated for full 
periods only. 

 

Instructions 
1. Go to the Properties, Tenants, or Income screen. 

2. Click on the Calculate Rents button . 

3. In the Income screen, the new Rents that are due display. 

4. This data is now ready for you to use as a reference.  

 

HINT: You can set up RPM to automatically calculate rents when you start the RPM 
software. See Setting Up Default Options for instructions. 
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Property Inspections 

The Inspections Screen 
As part of managing a property, you need to keep track of the condition of the 
property. You need to do this by Inspecting before a tenant moves in and after a 
tenant moves out. This allows you to compare the condition of the property and 
charge the tenant for any damages that have taken place. The record of your 
property condition is called an Inspection in RPM. RPM keeps complete Inspection 
records with your other property data. 

From the Inspection page, you can do the following: 

• Add or Edit Inspections 

• Delete an Inspection 

• Save Photos with Property Inspection Files 

• Create a Property Inspection Report Form 

To access functions, use the Inspections Toolbar. 

 
The main data table lists the Inspections that have taken place. To sort the 
Inspection list, click on a column item in the Inspection table heading. The Inspection 
list will be sorted based on that column.  

You must select an Inspection to add data to that Inspection, or to print its details as 
a Property Inspection Report.  
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Add or Edit Inspections 
You can add or edit an Inspection record for a property.  

 

Add an Inspection 

1. In the Inspections screen , click the Add Inspection button . 

2. The Inspection Details screen displays.  

3. Select the Property that is being inspected from the Property drop-down 
menu. 

4. Enter the additional data: 

• Unit 

• Tenant 

• Date Inspected 

• Check Out 

• Inspected By 

5. In the Check List tab, you will set up Categories to be checked, and specific 
items to be checked off within those Categories. This allows you to record the 
state of detailed areas of your property. 

6. Add , Edit , or delete Categories as required.  

7. To add check items to a Category, use the Add Item button . The 
Inspection Check Item screen displays. Enter the Name of the item and Notes 
about it, then click OK. The item displays in the check list for that Category.  

8. To record the status of an item in the check list, check one of its status 
boxes: Damaged, Fair, or Good. You can also add notes about that item.  

9. In the Photographs tab, you can save digital photos of the property, as 
evidence of its condition at the time of inspection. See Save Photos with 
Property Inspection Files for instructions. 

10. In the Notes tab, enter any Notes about the property inspection. 

11. Click OK.  

12. The Inspection is saved and added to the Inspection list. You can print out an 
Inspection as a Property Inspection Report Form, with or without photos. 

 

Edit an Inspection 

1. To Edit an Inspection, go to the Inspections screen . 

2. Select the Inspection you want to edit. Click the Edit Inspection button . 

3. The Inspection Details screen displays for that Inspection.  

4. Make changes to the Inspection as required, then click OK.  



Rental Property Manager 2 Manual 

30  Copyright © 2008, Source IT 

Delete an Inspection 
Deleting an Inspection is simple. 

 

Instructions 
1. In the Inspections screen, select the Inspection you want to delete. 

2. Click the Delete Inspection button . 

3. A message displays, asking, "Do you want to send this record to the recycle 
bin?" Click Yes to delete. 

4. The Inspection is deleted.  

5. Deleted Inspection records go to the Recycle Bin.  

 

Save Photos with Property Inspection Files 
You can save and manage digital photographs with Inspection files. Digital photos of 
your property provide a valuable reference for the property's condition. 

 

Instructions 
1. Before you begin, download the digital photos of your property onto your 

computer. RPM must be able to locate these photos on your computer. 

2. To add photos to an Inspection, go to the Inspections screen . 

3. Select the Inspection you want to edit. Click the Edit Inspection button . 

4. The Inspection Details screen displays for that Inspection.  

5. Go to the Photos tab of the Inspection Details screen. 

6. Click Add Photo . The Open screen displays. 

7. In the Open screen, locate the photo file on your computer. Select it. 

8. The photo opens in an Edit Photos screen. Add a caption to the photograph, 
noting its subject matter and the date when it was taken. Use the Back and 
Forward buttons at the top of the screen to move through and edit photos you 
have already saved. Once you have added /edited all photographs, click OK. 

9. The photos display in the Photos tab of the Inspection Details screen. 

10. You can edit a photo's caption by selecting it clicking Edit Photo . This 
opens the Edit Photos screen again. 

11. You can delete a photo by selecting it and clicking Delete Photo . 

 

HINT: If you do not want a photo to display in the Property Inspection Report Form, 
uncheck the Show in Report? box in the Photo data screen. 
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Manage Tenant Data 

The Tenant Screen 
The Tenant data screen has all tenant data and functions in one convenient location. 
From this screen, you can: 

• Add or Edit a Tenant (see Tenant Data Recommendations as well) 

• Delete Tenants 

• Email a Tenant 

• Add or Edit Notes 

• Calculate Rents 

• Add Income, Monies Due, or Received Payments 

• Review Rent Rates for a Tenant 

• Add or Edit Contacts 

• Add or Edit Photos 

• View Tenant reports: 

• Tenant List Report 

• Tenant Payments Report 

The top part of the screen includes the Tenant Toolbar.  

 
To search your tenant list by property, use the Filter menu. Select the property for 
which you want to view tenants; those tenants display.  

The center of the screen displays a database that lists all your tenants. You can sort 
your tenant data by clicking on the table headers.  

When you select a Tenant, the Tenant's rent payment records, contacts, photos, and 
Event Log appear in the lower half of the screen. You must select a Tenant to make 
changes to that Tenant.  
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Tenant Data Recommendations 
Your Tenant database is valuable. To help maintain your Tenant records, the 
following are recommended: 

• When you are setting up a Tenant, enter the Tenant's full legal name. If the 
Tenant commonly uses a nickname, add this to the Notes.  

• Use the Add Photo function to save scans or copies of a Tenant's 
identification, such as a driver's license. 

• Use the Notes section to record detailed information about the Tenant. This 
can include notes about pets, partners or children also living at the property, 
the Tenant's vehicles. 

• Use the Log section to record specific events about the tenant. This can 
include their requests for repairs, police incidents, and records of notice 
given. 

• When a tenant moves out, update the Rent Finished value in the Tenant Data 
screen. This way, they do not show up in reports and Calculate Rents 
functions as a current tenant. 

• Do not delete a Tenant, even when they move out and are no longer living at 
one of your properties. The Tenant's payment records will be useful for your 
taxes and investment records. You may be asked to provide a reference for 
the Tenant. A past Tenant may even move back to one of your Properties. 

 

Update Tenant Data 

To update Tenant Data, use the Edit a Tenant  function. See Add or Edit a Tenant 
to learn about the details of the Tenant Details screen. See Tenant Data 
Recommendations for advice about maintaining tenant data.  
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Send Email to Tenants 
RPM makes it easy to send email to one or more of your Tenants. 

 

Instructions 
1. In the Tenants screen, select the Tenant or Tenants you want to send an 

email to. 

2. Click the Email Tenant button . 

3. Your default email client opens a new email, with the email addresses of the 
selected tenants. 

4. Type and send your email.  

 

Delete Tenants 
Deleting a Tenant is simple. 

 

Instructions 
1. In the Tenants screen, select the Tenant you want to delete. 

2. Click the Delete Tenant button . 

3. A message displays, asking, "Do you want to send this record to the recycle 
bin?" Click Yes to delete. 

4. The Tenant is deleted.  

5. Deleted Tenant records go to the Recycle Bin.  
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Review Rent Rates for a Tenant 
You can review a Tenant's rent rates in RPM. You can also raise or lower their 
standard rent. The most recent rent rate will be applied as the tenant's rent. Review 
the rent for one tenant, or review and update all of your tenants. 

 

Instructions 
1. In the Tenants screen, select the Tenant for whom you want to review their 

rent rate. 

2. Click the View Rent Rates button . 

3. The Rent Rate screen displays. The data in the screen shows the history of 
the tenant's rent; the rent amount, the date when it was applied, the date 
when you will be reminded to review it; and any notes about the rent rise.  

4. To add a new rent rate, click the Add Rent Rate button.   Enter values 
for: 

• New Rent 

• Applies From - select a date 

• Review Date - select a date. On this date, RPM will prompt you to review 
and adjust the rent. 

• Notes 

5. Then, click OK. 

6. The new rent rate is added. 

7. To edit an existing rent rate, select it and click the Edit Rent Rate button 

. You can adjust and save the values.  

8. To delete a rent rate, select it and click the Delete Rent Rate button . 
Note that you cannot delete the first rent rate. 

9. When you are done in the Rent Rates screen, you may want to select the 
Recalculate Existing Rents check box. This will adjust existing rents to 
show your changes, starting at the "Applies From" date. 

10. Click OK to save your changes. You can also use the Show menu to select 
another tenant and view their rent rates.  



 

Copyright © 2008, Source IT  35 

Manage Financial and Contact Data 

Managing Financial Data  
RPM helps you manage your rental properties efficiently by linking all your property-
related financial data. Property records include the property purchase price and 
mortgage information. Tenant records include details about their deposits and rents. 
There are several areas for specific financial data in RPM: 

• Income - Money brought in as rent for properties. 

• Expenses - Money spent on properties in maintenance and asset 
expenditures. 

• Tenants - Money brought in or owed by specific tenants. 

 

There are data screens for both Income and Expenses in RPM. You can: 

• Add or Edit Expenses 

• Add Income, Monies Due, or Received Payments 

• Add or Edit Income from a Property 

 

Financial Reports include: 

• Expenses Report 

• Income & Expenses Report 

• Income & Expenses by Property Report 

• Tenant Payments Report 

 

There are also several rent-related functions: 

• The Calculate Rents Function adds rents that will be due in the next period to 
the Income screen. 

• Review Rent Rates for a Tenant allows you to review and adjust rents in one 
simple screen. 

• Add Income, Monies Due, or Payments functions enable you to add specific 
data to a specific tenant's financial records. 

• The Rent Outstanding Report lets you see which rents are overdue. 

• You can pro rate a first rental payment for a Tenant. 

• You can create custom fees for your Tenants. 

• You can record multiple payments at once. 
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The Income Screen 
The Income screen provides a summary of Income due and Income received from 
Tenants. From this screen, you can do the following: 

• Add or Edit Income and Recurring Income 

• Add Income, Monies Due, or Received Payments 

• Delete an Income Item 

• Calculate Rents 

• View Income reports: 

• Income & Expenses Report 

• Tenant Payments Report 

To access functions, use the Income toolbar. 

 
The main data table lists income due and income paid.  

To sort the Income list, click on a column item in the Income table heading. The 
Income list will be sorted based on that column.  

You must select an Income item to add data to that Income item. 

At the bottom of the page, there is a total number for both income due and income 
paid.  
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Add or Edit Income from the Income Screen 
From the Income screen, you can add or edit income. You can also copy an earlier 
income payment and edit its information, as a fast way to note a repeating payment. 

Income items that are DUE are generated by The Calculate Rents Function. To enter 
income DUE, see the Add Monies Due function. 

You must enter income PAID. These instructions describe how to enter income paid. 

You can edit both income DUE and income PAID items, but you cannot change an 
income DUE item into an income PAID item.  

Enter Income Paid 

1. To add an Income item, go to the Income screen . 

2. Click the Add Income button . 

3. The Income Details screen displays. 

4. Enter the values for the new item. Fields in yellow are mandatory; items in 
white are not. 

5. Click OK. The new Income item is saved and noted in the income totals at the 
bottom of the page.  

  
Copy an Income Item 

1. To Copy an Income item, go to the Income screen . 

2. Find and select the Income in the Income list. 

3. Click the Copy Income button . 

4. The Income Details screen displays. 

5. Edit the details. Make sure that you change the date, in particular, to 
show that this is a different income item.  

6. Click OK. The edited Income is saved as a new Income item. 

 

Edit an Income Item 

1. To Edit an Income item, go to the Income screen . 

2. Find and select the Income in the Income list. 

3. Click the Edit Income button . 

4. The Income Details screen displays. 

5. Edit the details, then click OK. The changed Income data is saved. 
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Income Details 
• Tenant - Select the Tenant who paid the Income. 

• Category - Select the Category of income. 

• Date due - Select the date when the Income was due. 

• Date paid - Date when the Income was paid. 

• Rent - This value is automatically displayed. 

• Amount Paid - Enter the amount paid by the tenant for this specific income 
payment. 

• Total Outstanding - This value is automatically calculated and displayed. 

• Reference - Enter a reference number for the payment, usually the invoice 
or check number. 

• Notes - Enter any notes about the income. 

• Receipt - Generate a Receipt document for this income. 
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Add Income, Monies Due, or Received Payments for a Tenant 
There are multiple ways to update specific financial information for your individual 
tenants: 

• Add Income - Use this when a tenant has submitted a partial payment. 

• Add Monies Due - Use this when a tenant owes money related to their 
tenancy. 

• Add a Tenant Late Fee - Use this when you need to add a late fee to a 
tenant's monies due. 

• Support a Tenant Credit Check - Support a credit check of a tenant with 
documentation. 

• Insufficient funds function?  

• Mark as Paid - Use this when a tenant has submitted all monies due.  

 

Note that if a data field is yellow, that data is required for the financial record. If a 
data field is white, that data is optional. 

 

Add Income 
1. In the Tenant screen or the Income screen, click the Add Income button 

.  

2. The Add Income screen displays. Enter the information about the payment 
received: 

4. Click OK. 

5. The new income is recorded against the tenant. 
Income Details Screen Values 

• Tenant - Select the Tenant who paid the Income. 

• Category - Select the Category of income. 

• Date due - Select the date when the Income was due. 

• Date paid - Date when the Income was paid. 

• Rent - This value is automatically displayed. 

• Amount Paid - Enter the amount paid by the tenant for this specific income 
payment. 

• Total Outstanding - This value is automatically calculated and displayed. 

• Reference - Enter a reference number for the payment, usually the invoice 
or check number. 

• Notes - Enter any notes about the income. 

• Late Fee - Select a late fee calculation option for this income. 

• Invoice - Click this button to automatically generate a printable or emailable 
Invoice file. 

 

Add Monies Due 
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1. In the Tenant screen or the Income screen, click the Add Monies Due 

button .  

2. The Add Monies Due screen displays. Enter the information about the 
payments due. 

3. Click OK. 

4. The monies due are recorded against the tenant. 
Income Due Details Screen Values 

• Tenant - Select the Tenant who paid the Income. 

• Category - Select the Category of income. 

• For Period - Select the date period that this income will be applied against. 

• Date due - Select the date when the Income was due. 

• Amount Due - Enter the amount due. 

• Notes - Enter any notes about the income. 

• Invoice - Click this button to automatically generate a printable or emailable 
Invoice file. 

 

Add a Late Fee to a Tenant 
1. In the Tenant screen In the Tenant screen or the Income screen, go to the 

Add Monies Due button. 

2. Beside the Add Monies Due button , click the drop-down menu. 
Select Add Late Fee. 

3. The Income Details screen displays for the tenant. Edit the Late Fee field. 

4. Click OK. 

5. The new Late Fee is recorded against the tenant and added to their monies 
due. 

 

Support a Tenant Credit Check 
1. In the Tenant screen In the Tenant screen or the Income screen, go to the 

Add Monies Due button. 

2. Beside the Add Monies Due button , click the drop-down menu. 
Select Credit Check. 

3. The Income Due screen displays for the tenant. 

4. Click the Invoice button. 

5. Save the Invoice file. 

6. Use the Invoice as a record of their monies due to support a credit check. 

 

 

Mark Tenant as Paid 
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1. In the Tenant screen In the Tenant screen or the Income screen, select an 
item for a Tenant. 

2. Click the Mark as Paid button . All the Tenant's outstanding 
payments are marked as paid. 

3. Another way to use this function is to click the drop-down menu for the Mark 
as Paid button. You can select: 

• Mark as paid - for one tenant. 

• Mark selected as paid - for more than one tenant. 

 

 

 

 

Delete an Income Item 
Deleting an Income Item is simple. 

 

Instructions 
1. In the Income screen, select the Income you want to delete. 

2. Click the Delete Income button . 

3. A message displays, asking, "Do you want to send this record to the recycle 
bin?" Click Yes to delete. 

4. The Income is deleted.  

5. Deleted Income records go to the Recycle Bin.  
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The Expenses Screen 
The Income screen provides a summary of Income due and Income received from 
Tenants. From this screen, you can do the following: 

• Add or Edit Expenses and Recurring Expenses 

• Delete an Expense 

• Add Notes to an Expense 

• View Expense reports: 

• Income & Expenses Report 

• Expenses Report 

To access functions, use the Expense toolbar. 

 
The main data table lists all paid expenses. To sort the Expense list, click on a 
column item in the Expense table heading. The Expense list will be sorted based on 
that column.  

You must select an Expense item to add data to that Income item. 

At the bottom of the page, there is a total number as a summary of all expenses.  
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Delete an Expense Item 
Deleting an Expense Item is simple. 

 

Instructions 

1. In the Expense screen , select the Expense you want to delete. 

2. Click the Delete Expense button . 

3. A message displays, asking, "Do you want to send this record to the recycle 
bin?" Click Yes to delete. 

4. The Expense is deleted.  

5. Deleted Expense records go to the Recycle Bin.  
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The Contacts Screen 
The Income screen provides a summary of Income due and Income received from 
Tenants. From this screen, you can do the following: 

• Add or Edit Contacts 

• Delete a Contact 

• Add Notes to a Contact 

• Add a Photo to a Contact's Records - Use this to save images of work the 
contact has done, copies of the contact's scanned qualifications or ID. 

• Add an Event Log entry for a Contact 

 

To access functions, use the Contact toolbar. 

 
The main data table lists all contacts. To sort the Contact list, click on a column item 
in the Contact table heading. The Contact list will be sorted based on that column.  

When you select a Contact, the Contact's photos and Event Log appear in the lower 
half of the screen.  



Manage Financial and Contact Data 

Copyright © 2008, Source IT   45 

Add or Edit Contacts 
You can add or edit data about Contacts. A Contact is a person, service provider, or 
organization that is involved in your properties. Examples of these would be: 
cleaners, plumbers, electricians, rental agencies, banks, and local government. A 
Contact can be associated with a specific property and/or a specific tenant. 

 

Add a New Contact 
1. To add a new Contact, go to the Contacts or Tenants screen. 

2. Click on the Add Contact button . 

3. The Contact Details screen displays.  

4. Complete the Contact Data by typing/selecting the information into each field. 

5. If a data field is yellow, that data is required for the tenant record. If a data 
field is white, that data is optional. 

6. When all the data required/available is entered, click OK.  

7. The Contact data is saved.  

 

Edit a Contact 
1. To Edit a tenant, go to the Contact screen . 

2. Find and select the Contact in the Contact list. 

3. Click the Edit Contact button . 

4. The Contact Details screen displays. 

5. Edit the details, then click OK. The changed Contact data is saved.  

  
Contact Details Screen Values 

• Property - If desired, link a Property to the Contact. 

• Tenant - If desired, link a Tenant to the Contact. 

• Category - Select a Category for the Contact. 

• Last Name 

• First Name 

• Title 

• DOB - Date of Birth, if relevant. 

• Company 

• Email 

• Mobile Phone 

• Home Phone  

• Work Phone 

• Contact Address 

• Notes - Enter any notes about the Tenant.  
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Delete a Contact 
Deleting a Contact is simple. 

 

Instructions 
1. In the Contact screen, select the Contact you want to delete. 

2. Click the Delete Contact button . 

3. A message displays, asking, "Do you want to send this record to the recycle 
bin?" Click Yes to delete. 

4. The Contact is deleted.  

5. Deleted Contact records go to the Recycle Bin.  
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Using the RPM Planner 

About the RPM Planner 
The RPM Planner screen has all tenant data and functions in one convenient location. 
From this screen, you can: 

• Add or Edit a Planner Event 

• Setting Recurrent Planner Events 

• Delete a Planner Event 

You can also Print the Planner view. 

The top part of the screen includes the Planner Toolbar.  

 
To review your Planned Events, use the View menu.  Select one of the View options: 

• Month - In the Month view, Events are shown in a table that lists the days of 
each month, and all the properties, showing events at a glance for each 
month. 

• Events - In the Events view, Events only are listed with Event data. In the 
Event view, you can sort your Event data by clicking on the table headers.  

To view Events for a selected Property, use the Filter menu. Select the property for 
which you want to view events. 

You must select an Event to make changes to that Event.  
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Add or Edit a Planner Event 
You can add or edit property-related Events in the RPM Planner. An Event is an 
inspection, rent due date, or other event related to one of your properties. You may 
need to go to the property in person, or arrange for a service or a phone call. Follow 
the instructions below to add or edit a planner Event. You can also add or edit an 
event by double-clicking the calendar. 

 

Add a New Event 

1. To add a new Event, go to the Planner screen . 

2. Click on the Add Event button . 

3. The Event Details screen displays.  

4. Complete the Event Data by typing/selecting the information into each field. 

5. If a data field is yellow, that data is required for the Event record. If a data 
field is white, that data is optional. 

6. When all the data required/available is entered, click OK.  

7. The Event data is saved. The Event is assigned to the selected Property and 
displays in the Event screen.   

 

Edit an Event 

1. To Edit an Event, go to the Planner screen . 

2. Find and select the Event in the Event list. 

3. Click the Edit Event button . 

4. The Event Details screen displays. 

5. Edit the details, then click OK. The changed Event data is saved.  

  

Event Details Screen Values 
If an Event occurs in the past, you can only view the Events values; you cannot edit 
them.  

• Subject - Title of Event. 
• Start time - Start day and time of Event. 
• End time - End day and time of Event. 
• Repeats - Note if this event will repeat. To edit this, click the Edit button and 

use the Recurrency screen, as described in Setting Recurrent Planner Events. 
• Notes - Enter any notes about the Event. 
• Reminder - Check this to activate a Reminder message. To set the amount 

of time before the event that prompts the reminder, select the time from the 
drop-down menu. 

• Property - Select any related Property from the drop-down menu. 
• Tenant - Select any related Tenant from the drop-down menu. 
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Setting Recurrent Planner Events 
A recurrent event is an event that repeats over multiple days, weeks, months, or 
years. An example of a recurrent event is a rental payment. You can set up recurrent 
events in the Planner. 

 

Add a New Event 

1. To add a new Event, go to the Planner screen . 

2. Click on the Add Event button . 

3. The Event Details screen displays.  

4. Complete the Event Data by typing or selecting the information into each 
field. If a data field is yellow, that data is required for the Event record. If a 
data field is white, that data is optional. 

5. When all the data required/available is entered, click OK.  

6. The Event data is saved. The Event is assigned to the selected Property and 
displays in the Event screen. The Event will be added to the Planner calendar 
at the required recurrency intervals. 

 

Recurrency Values 
Settings Tab 

Recurrency Pattern 

Select one of the following: 

• None 
• Hourly 
• Daily 
• Weekly 
• Monthly 
• Yearly 

Pattern Details 

Select an Interval Value (1, 2, 3) and enter the recurrency details. These details vary 
based on the type of recurrency you choose. 

Range 

Set up the range of the event recurrency by selecting one of the following options: 

• Infinite 

• For X occurrences  

• Until X date 
 
Exceptions 

Set up any Exceptions, i.e., times when the recurrent message should not be 
activated or prompted, for example, a holiday or leap year day. Select the To and 
From date and time. You can use the buttons to add or remove exceptions, or Clear 
all exceptions.  



Rental Property Manager 2 Manual 

50  Copyright © 2008, Source IT 

Delete a Planner Event 
Deleting a Planner Event is simple. 

 

Instructions 

1. In the Planner screen , select the Event you want to delete. 

2. Click the Delete Event button . 

3. A message displays, asking, "Do you want to send this record to the recycle 
bin?" Click Yes to delete. 

4. The Event is deleted. Recurring Events are deleted across all the recurring 
dates. 

5. Deleted Event records go to the Recycle Bin.  
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Property and Finance Reports 

About Reports 
RPM Reports provide complete details about your properties. The reports give you 
easy reference files for reviewing your property-related information and finances.  

 

HINT: You can also share your valuable RPM data with others via the reports. These 
reports can printed out and given to real estate agents, accountants collection 
agencies, and others performing property actions on your behalf.  

 

Every report has a title and the date when the report was created. 

How can you use the different reports? Some suggestions for each report are listed 
below. 

• Asset List Report - Compare assets at your different properties to see what 
needs to be upgraded, or note what has been added in the past year. 

• Blank Report - Use this as a basis for building your own report. 

• Blank Inspection Report - Use this as a form when inspecting a property. 

• Dimensions Report - Compare the spaces at your different properties for 
marketing and maintenance. 

• Expenses Report - See at a glance which property is costing the most in 
maintenance. 

• Expenses by Property Report - Review expenses for a particular property. 

• Income Report - Review your overall income from your rental properties. 

• Income and Expenses Report - Fast and easy way to see if properties are 
making, or losing, money. 

• Income and Expenses by Property Report - Review income and expenses for a 
particular property. 

• Inspection Report - A report with information recorded during an Inspection 
for a particular property. 

• Inspection Report with Photos - A report with information and photos from an 
Inspection for a particular Property. 

• Invoice - Click this to generate an invoice document with report editing 
capabilities. 

• Property List Report - A list of all your properties and their current status. 

• Property Summary - Describes the financial activity for all of your Properties 
within a selected date range. 

• Property Inspection Report - Review the most recent dates for all inspections. 

• Rent Outstanding Report - Review outstanding rents for all properties. 

• Receipt - Click this to generate a receipt document with report editing 
capabilities. 

• Summary Report - A list of your total Income and Expenses for a selected 
date range. 
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• Tenant Details Report - A list of tenant data focusing on tenancy length, 
deposits, and deposits returned. 

• Tenant List Report - Complete and detailed list of tenants. 

• Tenant Payment Summary - A list of tenants with their contact information 
and current financial status. 

• Tenant Payments Report - Find out which tenants owe money and act to 
collect! 
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View Reports 
It is easy to view reports. The instructions below describe how to view reports with 
data and how to use the Reports Toolbar. 

 

Viewing Reports 

1. From a data Screen,  click the Reports  button. A drop-down menu 
displays, listing all the report options for that data Screen. 

2. To view a list of all available reports, in the View menu click Reports, or 
from the Reports button, click the Show All Reports option. A small screen 
displays, listing all the report options. 

3. In the menu or screen, click on the Report you want to view. 

4. The report displays. Use the Reports Toolbar to view, save, & export. 

The Reports Toolbar 

 
Print the report. 

 
Use the Zoom navigation to change how you view the report on your 
computer screen.  
Zooming Out, or to a smaller percentage, makes the report smaller, 
so that you can see more of it on your screen. 
Zooming In, or to a larger percentage, makes the report larger, so 
that you can read details.  

 
Open a saved report. 

 
Save a report. 

 
Export a report into a different file or graphic format. 

 
Save the report as a PDF file. 

 
Send the report via an email. 

 
Search the report. 

 
Use the arrows and page number field to navigate to different 
pages of a multi-page report. 

 
View the report using the full screen. 

 
View the report with an outline in the left sidebar. 

  
View the report with thumbnails of report pages in the left sidebar. 

  
Change the paper size and other page settings of the report. 

 
Edit the value headers and other text displayed in this report.  

 
Close the report. 
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Editing Reports 
You can edit the field titles and other text in a Report. When you want to Edit a 
report, RPM will open a new function module called FastReport. FastReport includes 
its own online help with detailed instructions. However, we have included the basic 
elements of working with FastReport for RPM report files below.  

 

Instructions 
1. View a Report. 

2. The Edit button appears in the Report toolbar. Click this button.  

3. The FastReport utility displays. 

4. Use FastReport to make changes to your report.  

5. To edit an item, right-click it and select Edit. A window displays for you to 
make changes to text. 

6. To save an edited report, click File - Save. A Save Screen displays. 

• To save this report as a once-only report, save it in any folder location. 

• To save your changes to be used in all versions of this report, navigate to the 
RPM program installation and save the file in the folder SystemReports. Save 
it without changing its file name. When you use this report in the future from 
RPM, it will have your values.  

7. When you exit FastReport (File - Exit), you are returned to the report in 
RPM. 

 

 

Search Reports 
It is easy to run a basic text search of a Report. 

 

Instructions 
1. View a Report. 

2. The Search button  appears in the Report toolbar. Click this button and a 
Find Text field displays.  

3. In the Text field, enter the term or number you want to find. Use the "case 
sensitive" or "search from beginning" options, if required. Click OK.  

4. The term will be highlighted in the report. If it is not found, a message will tell 
you that it is not in the report. 
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Asset List Report 
The Asset Report displays a complete list of all the Assets for a selected Property. 
This is useful for managing maintenance and renovations of properties, tax purposes, 
and communicating with potential renters. 

To View this report, select the Property in the Property screen. Then go to the 

Reports button and select the Assets report. 

 

Report Data 
The following data is listed for each Property: 

Name and 
Address 

The name and full address of the Property. 

The following data is listed for all the dimensions at each Property: 

Category Category of Asset described below. 

Asset Name of the specific Asset. 

Details Description of the Asset. 

Purchase 
Date 

Date when asset was purchased. 

Purchase 
Price 

Value of asset at time of purchase. 

Notes Notes about the Asset. 
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Blank Report 
The Blank Report is different from other reports. This report has no values in it 
except for the Property list. It is here as a template for you to use in creating and 
saving your own reports using the FastReport function, accessed by clicking the Edit 

Report button . See Editing Reports for basic information. 

 

Dimensions Report 
The Dimensions Report displays a complete list of the Dimensions for a selected 
Property. This is useful for managing maintenance and renovations of properties, 
estimating utility expenses, and communicating with potential renters. 

To View this report, select the Property in the Property screen. Then go to the 

Reports button and select the Dimension report. 

 

Report Data 
The following data is listed for each Property: 

Name and 
Address 

The name and full address of the Property. 

The following data is listed for all the dimensions at each Property: 

Category Category of Dimension described below. 

Name Name of the Dimension area. 

Dimensions Measurements, area, or other reference information 
for the Dimension area. 
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Expenses Report 
The Expenses Report displays a complete list of Expenses for all your Properties. This 
is useful for tax deductions related to properties. You will be prompted to choose a 
date period for this report. 

To View this report, go to the Reports button and select the Expenses report. 

 

Report Data 
The following data is listed for each Property: 

Tax 
Status 

Whether or not the expense is tax-deductible.  

Category Category of the expense. 

The following data is listed for the expenses in each Tax Status and Category: 

Date Date of the expense. 

Property Property for the expense. 

Details Any data you entered for the expense. 

Description Description that you entered for the expense. 

Reference Invoice, check number, or other reference 
information for the expense. 

Subtotal Subtotal of expenses for this tax status and category 

Grand 
Total 

Total expenditures for the report. 
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Expenses by Property Report 
The Expenses by Property Report displays a complete list of Expenses for a selected 
Property. This is useful for tax deductions related to properties. You will be prompted 
to choose a date period for this report. 

To View this report, select the Property in the Property screen. Then go to the 

Reports button and select the Expenses by Property report. 

 

Report Data 
The following data is listed for each property: 

Property The name of the property. 

Address The address of the property. 

The following data is listed to summarize expenses: 

Tax 
Status 

Whether or not the expense is tax-deductible.  

Category Category of the expense. 

The following data is listed for the expenses in each Tax Status and Category: 

Date Date of the expense. 

Property Property for the expense. 

Details Any data you entered for the expense. 

Description Description that you entered for the expense. 

Reference Invoice, check number, or other reference 
information for the expense. 

Subtotal Subtotal of expenses for this tax status and category. 

Subtotal 
for 
Property 

Subtotal of expenses for the property. 

Grand 
Total 

Total expenditures for the report. 
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Income Report 
The Income Report displays a complete list of Income for all your Properties. This is 
useful for tax related to properties. You will be prompted to choose a date period for 
this report. 

To View this report, in the Income screen, go to the Reports button and 
select the Income report. 

 

Report Data 
The following data is listed for each Property: 

Tax 
Status 

Whether or not the income is taxable.  

Category Category of the income. 

The following data is listed for the expenses in each Tax Status and Category: 

Date Date of the income 

Property Property for the income 

Details Any data you entered for the income, usually the 
payer. 

Reference Invoice, check number, or other reference information 
for the income. 

Subtotal Subtotal of income for this tax status and category 

Grand 
Total 

Total income for the report. 
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Income and Expenses Report 
The Income & Expenses by Property Report displays a complete list of all Income and 
Expenses, listed by Tax Status and Category. 

To View this report, in the Income or Expenses screen, go to the Reports button 

and select the Income and Expenses report. 

 

Report Data 
The following data is listed: 

Tax 
Status 

Whether or not the income or expense is tax-
deductible.  

Category Category of the income/expense. 

The following data is listed for the incoming and outgoing funds in each Tax Status 
and Category: 

Date Date. 

Property Property for the entry 

Details Any data you entered. 

Description Description that you entered. 

Reference Invoice, check number, or other reference 
information. 

Expense Any expenses related to the date. 

Income Any income related to the date. 

Subtotals 
for 
categories 

Subtotal of income and expenses for this tax status 
and category. 

Grand 
Total 

Total income and expenditures. 

 

 



Property and Finance Reports 

Copyright © 2008, Source IT   61 

Income and Expenses by Property Report 
The Income & Expenses by Property Report displays a complete list of all your 
properties and their associated Income and Expenses. Each Property has its own 
page in this report.  

 

To View this report, select the Property in the Property screen. Then go to the 

Reports button and select the Expenses by Property report. 

 

Report Data 
The following data is listed for each Property: 

Tax 
Status 

Whether or not the income or expense is tax-
deductible.  

Category Category of the income/expense. 

The following data is listed for the incoming and outgoing funds in each Tax Status 
and Category: 

Date Date. 

Property Property for the entry 

Details Any data you entered. 

Description Description that you entered. 

Reference Invoice, check number, or other reference 
information. 

Expense Any expenses related to the date. 

Income Any income related to the date. 

Subtotals 
for 
categories 

Subtotal of income and expenses for this tax status 
and category. 

Total for 
Property 

Total income and expenditures for the property. 
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Inspection Report Form 
The Property Inspection Report Form has three uses: 

• Providing a summary of an Inspection for review. 

• Providing a form/checklist with data from previous Inspections to be used as 
a comparison for a current inspection. 

• Providing a blank form/checklist to be used for a current inspection. 

You can create a Property Inspection Report form in three levels. These instructions 
are for an Inspection Report that includes data from the Inspection files, but does 
not include any property photographs. 

To View this report, in the Inspections screen, go to the Reports button and 
select the Inspection Report. 

 

Report Data 
The following data is listed for each Property: 

Name and 
Address 

The name and full address of the Property. 

Unit If applicable, the specific unit of the property. 

Tenant The tenant renting the property during the inspection. 

Inspection 
Date 

Date of the inspection. 

Check Out Check this box if the inspection date is the tenant's 
moving out date. 

Inspected 
By 

Person who did the inspection.  

General 
Notes 

Notes entered about the inspection.  

The following data is listed for the inspection at the Property: 

Category Category of Inspection Area (Dimension) described in 
an Inspection section. 

Notes Notes about this Inspection Area. 

Checklist 
Items 

List of items inspected for this Category. For each item, 
the following is noted with a check: 

• Condition as Damaged, Fair, Good 

• Notes 
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Inspection Report with Photos 
The Property Inspection Report Form has three uses: 

• Providing a summary of an Inspection for review. 

• Providing a form/checklist with data from previous Inspections to be used as 
a comparison for a current inspection. 

• Providing a blank form/checklist to be used for a current inspection. 

You can create a Property Inspection Report form in three levels. These instructions 
are for a Report including data and photographs from the Inspection file. 

To View this report, in the Inspections screen, go to the Reports button and 
select the Inspection Report with Photos report. 

 

Report Data 
The following data is listed for each Property: 

Name and 
Address 

The name and full address of the Property. 

Unit If applicable, the specific unit of the property. 

Tenant The tenant renting the property during the inspection. 

Inspection 
Date 

Date of the inspection. 

Check Out Check this box if the inspection date is the tenant's moving 
out date. 

Inspected 
By 

Person who did the inspection.  

General 
Notes 

Notes entered about the inspection.  

The following data is listed for the inspection at the Property: 

Category Category of Inspection Area (Dimension) described in an 
Inspection section. 

Notes Notes about this Inspection Area. 

Checklist 
Items 

List of items inspected for this Category. For each item, 
the following is noted with a check: 

• Condition as Damaged, Fair, Good 

• Notes 

Inspection 
Photographs 

If you have created the Property Inspection Report with 
the Photographs option, all the Photographs are grouped 
together with their titles at the end of the Report.  
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Blank Inspection Report Form 
You can create a Property Inspection Report form in three levels. These instructions 
are for creating a blank one to use as a form. This is a useful checklist for the 
property inspector on site. They can return it to your RPM user, who will enter the 
values into RPM easily.  

To View this report, in the Inspections screen, go to the Reports button and 
select the Blank Inspection Report. 

 

Report Data 
The following data is listed without any values, for the property inspector to 
complete: 

Name and 
Address 

The name and full address of the Property. 

Unit If applicable, the specific unit of the property. 

Tenant The tenant renting the property during the inspection. 

Inspection 
Date 

Date of the inspection. 

Check Out Check this box if the inspection date is the tenant's 
moving out date. 

Inspected 
By 

Person who did the inspection.  

General 
Notes 

Notes entered about the inspection.  

The following data is listed for the inspection at the Property: 

Category Category of Inspection Area (Dimension) described in 
an Inspection section. 

Notes Notes about this Inspection Area. 

Checklist 
Items 

List of items inspected for this Category. For each item, 
the following is noted with a check: 

• Condition as Damaged, Fair, Good 

• Notes 
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Property List Report 
The Property List displays a complete list data about your Properties. This is useful 
for as an overview of your property holdings, availability, and mortgage status.  

To View this report, in the Property screen, go to the Reports button and 
select the Property List report. 

 

Report Data 
The following data is listed for each property: 

Property The name of the property. 

Address The address of the property. 

Notes Any Notes listed about the property. 

Purchase 
Date 

Date when you purchased the property. 

Value The value of the property. 

Mortgage The outstanding mortgage on the property, if any. 

 

 

Property Summary Report 
The Property Summary displays financial data for each of your Properties. This is 
useful for as an overview of your property income and expenses. Each property 
displays on a separate page of the report. 

 

To View this report, in the Property screen, go to the Reports button and 
select the Property Summary report. 

 

Report Data 
The following data is listed for each property: 

Property The name of the property. 

Expense The address of the property. 

Income Any Notes listed about the property. 

Total Date when you purchased the property. 
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Rent Outstanding Report 
This Report lists all the tenants who owe outstanding rent. It includes contact 
information for the tenant, so that a person using this report can get in touch with 
the tenants to request the overdue rent.  

To View this report, in the Tenants screen, go to the Reports button and 
select the Rent Outstanding Report. 

 

Report Data 
The following data is listed for each Tenant who has overdue rent: 

Tenant Full name of the Tenant. 

Property Name and address  of the Property where the tenant 
is renting. 

Mobile, 
Home, 
Work 

Mobile, home, and work telephone numbers entered 
for that Tenant. 

Email Email address for that Tenant. 

Due Amount due from this tenant. 

As At Date when Amount Due has been noted. 

Paid Amount paid by this tenant. 

Last 
Payment 

Date of most recent payment by this tenant. 

Outstanding Amount still owed by this tenant. 

Total Due Total amount still due. 

Total Paid Total amount paid. 

Total 
Outstanding 

Total amount outstanding. 
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Summary Report 
The Summary Report displays a concise list, distilled to its essence, of all Income 
and Expenses, for a selected date range. This is useful when calculating annual 
taxes, or to view your overall profit or deficit. 

 

To View this report, in the Income or Expenses screen, go to the Reports button 

and select the Summary Report. 

 

Report Data 
The following data is listed: 

Expenses Any expenses incurred during the selected date range. 

Income Any income received during the selected date range. 

Totals for 
categories 

Subtotal of income and expenses. 

Total Total profit or deficit after expenses are subtracted 
from income. 
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Tenant Details Report 
The Tenant Details report displays a complete list of information about all of your 
tenants. It is specifically useful for reviewing the length of tenancy and deposit 
versus deposits returned.  

To View this report, in the Tenants screen, go to the Reports button and 
select the Tenant List Report. 

 

Report Data 
The following data is listed for each Tenant: 

Tenant First name, last name, and title of a tenant. 

Company The tenant's place of employment or business. 

Tenancy The dates during which the tenant is or was occupying 
a property. 

Property The name and full address of the Property the tenant 
is or was renting. 

Work, 
Mobile, 
Home 

The Notes you have entered for the Property. 

Deposit The amount a tenant paid as a deposit before renting 
the Property. 

Returned The amount of any deposit returned to the tenant at 
the end of their tenancy. 
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Tenant List Report 
The Tenant List report displays a complete list of all your properties and their 
associated tenants.  

To View this report, in the Tenants screen, go to the Reports button and 
select the Tenant List Report. 

 

Report Data 
The following data is listed for each Property: 

Name 
and 
Address 

The name and full address of the Property. 

Notes The Notes you have entered for the Property. 

The following data is listed for the Tenants at each Property: 

Name Full name of the Tenant. 

Rent Rent and frequency of rent payments for this Tenant.  

Mobile, 
Home, 
and 
Work  

Mobile, home, and work telephone numbers entered for 
that Tenant. 
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Tenant Payments Report 
The Tenant Payments report displays a complete list of all the payments made by a 
selected Tenant. Rent and deposits are included. 

 

To View this report, select the Tenant in the Tenants screen. Then go to the 

Reports button and select the Tenant Payment Report. 

 

Report Data 
The following data is listed for each Tenant: 

Tenant Full name of the Tenant. 

Mobile, 
Home, 
Work 

Mobile, home, and work telephone numbers entered 
for that Tenant. 

Property Name of the Property where the tenant is renting. 

Address Address of the Property where the tenant is renting. 

Period Time period of a payment. 

Date Date of a payment. 

Category Category of a payment, normally Rent. 

Due Amount due at that date, if it has not been paid. 

Paid Amount that was paid on the noted date. 

Arrears 
Notes 

Any payments overdue/in arrears as of the noted date. 

Totals: Totals of money Due and money Paid by the tenant 
during their tenancy at your property. 
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Tenant Payment Summary 
The Tenant Payments Summary report displays a list of all Tenants, the totals of the 
money they have paid and they owe, and their contact information. It is a 
convenient document to help contact tenants in arrears. 

To View this report, in the Tenants screen, go to the Reports button and 
select the Tenant Payment Summary Report. 

 

Report Data 
The following data is listed for each Tenant: 

Tenant Full name of the Tenant. 

Mobile, 
Home, 
Work 

Mobile, home, and work telephone numbers entered for 
that Tenant. 

Property Name of the Property where the tenant is renting. 

Address Address of the Property where the tenant is renting. 

Due Amount due at that date, if it has not been paid. 

Paid Amount that was paid on the noted date. 

Arrears  Any amount overdue/in arrears. 
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Databases 

About Databases 
RPM saves your property information as data, in a group of linked files called a 
Database. RPM is installed with a database that contains sample data. You can 
continue to save information in this database, but we recommend that you create a 
new database for your property data. 

Creating Databases is easy in RPM. You can reopen a saved database at any time. 
You may even want to have multiple databases for different groups of rental 
properties. You could set up different data sets, with Assets and Dimensions and 
Options defaults, for residential and commercial properties, for example. To review 
the database you wanted, you would Open the Saved Database. 

You can also: 

• Repair a Database - Run an update of your database files, a combination of 
restoring data from system backups with the addition of changes made to the 
database since the backup (typically using log files). 

• Restore a Database - Open and re-implement your database Backup file. 

 

NOTE: In RPM, changes to the open database are saved automatically. This is done 
whenever you click OK, or change to another row. 
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Creating Databases of RPM Data 
You can create a database file from your RPM property data. Before you begin to 
enter data, you should create a database. The data you enter will be saved in the 
selected database. 

 

Instructions 
1. In the File menu, select Create Database. 

2. The New Database screen displays. 

3. In the Database Name field, enter the name of the new database file. 

4. In the Database Location field, click on the folder icon. Browse your PC for the 
system location of the new database file. IMPORTANT: Microsoft Vista users 
must create the database in their My Documents folder.  

5. Click OK. 

6. The new database is created and saved. You can: 

• Save the database as a backup 

• Send the database to another RPM user for them to use 

 

Opening a Saved Database 
You can open a saved RPM database file in RPM. 

NOTE: Do NOT try to open a database file that has not been created using RPM with 
this program.  

 
Instructions 

1. In the File menu, select Open Database. 

2. The Open screen displays. 

3. Browse your PC for the system location of the database file that you want to 
open. 

4. Select the file and click OK. 

5. The selected database is opened. 
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Back Up a Database 
You can and should back up your databases. Backing up your database protects your 
data in case of a system or software failure. If there is a failure or a problem, the 
backup file makes it possible to fully recover the database.  

NOTE: The more data you have in your database, the more important it is to back it 
up. You may want to save your backups in a secure file location that is not on your 
computer, i.e., on a flash drive or a CD-ROM.  

 
Instructions 

1. In the File menu, select Backup Database. 

2. The Save As screen displays. 

3. Browse your PC for the system location where you want to save the file. 

4. Make sure that the file has a name that is meaningful to you. The default file 
name is: 

<database_name><date>.rpmbackup 

5. Click OK. 

6. The database is saved. 

 

Restore a Database 
If you are having database or system problems, you may want to restore a backed-
up database. Restoring a database opens and re-implements your database Backup 
file. It restores all your data up to the date and time of the backup.  

NOTE: Do NOT try to open a database file that has not been created using RPM with 
this program.  

 
Instructions 

1. In the File menu, select Restore Database. 

2. The Open screen displays. 

3. Browse your PC for the system location of the database file that you want to 
open. 

4. Select the file and click OK. 

5. The selected database is opened. Your data is restored up to the time and 
date when the backup file was saved. 
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Repair a Database 
What if you are having database or system problems - and you have forgotten to 
create a database Backup for a while? You can try to run a Repair of the database. 

A Repair of the database is an update of your database files, a combination of 
restoring data from system backups with the addition of changes made to the 
database since the backup (typically using log files). 

A Repair is not a guaranteed fix. It is not as good as a backed up database that you 
restore.   

 
Instructions 

1. In the File menu, select Repair Database. 

2. The Open screen displays. 

3. Browse your PC for the system location of the database file that you want to 
use as the basis of the Repair. 

4. Select the file and click OK. 

5. RPM processes the repair. This may take a few minutes. 

6. The selected database is opened. Your data displays. 

7. Save the Repaired database. 

 

Password Protect a Database 
Your financial and property information is valuable. To support your security, you 
may want to protect your databases with passwords. You can also remove passwords 
from databases, using the Remove Password command.  

NOTE: Please keep records of your passwords.  

 
Instructions 

1. In the File menu, select Password Protect. 

2. The Password screen displays. 

3. Enter the password that you want to use for this database. 

4. Click OK. 

5. In future, if you want to open this database, you must enter the password. 
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Tutorials and FAQs 

About Tutorials and FAQs 
To help you teach yourself how to use RPM to is fullest potential, this section includes 
tutorials about advanced RPM functions. This section includes our Frequently Asked 
Questions list.  

It also includes step-by-step reviews of the following processes: 

• Customizing and Viewing New Data Fields 

• Creating Late Fees 

• Creating Custom Fees 

• Pro Rating a First Rent Payment 

• Recording Payments from Multiple Tenants 

 

If there is a tutorial or FAQ you would like to see, please contact Source IT. We are 
happy to answer your questions as part of product support. 

 

Frequently Asked Questions About RPM 
 

Is Rental Property Manager Vista compatible? 

RPM version 1.30 and later are Vista compatible. However, Vista users have to use a 
specific system location to save a database. Note that version 1.30 is a free upgrade 
for registered users. 

 

Can Rental Property Manager display values in any currency? 

RPM uses the values from your Windows Regional Settings for displaying currencies. 
For example, if you are set up with New Zealand regional settings, the currency will 
display as New Zealand dollars. Regional Settings also apply to date and time 
records in RPM> 
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Customizing and Viewing New Data Fields 
This tutorial describes how to add a custom field to your data Details.   

As an example, this tutorial will add the custom field “Second Tenant” to Tenant 
data.  Every time the user goes to enter or edit a Tenant, they will be able to enter 
data in the “Second Tenant” field. The same process can also be used to add custom 
fields to Contacts, Expenses, Income, Inspections, and Property. 

 

Adding the custom field 
1. Go to the Tools menu, and click on Options. 

2. In the Options screen, go to the Custom Fields page. 

3. In the Selection drop-down menu, choose the section of RPM data that needs 
a custom field. Here, select the section Tenant.  

 
1. Next, check the Show box beside Field 1 (Text). 

2. Type Second Tenant into Name.  

3. Click OK.  

4. The custom field of Second Tenant has been saved for Tenant data. 

  

Entering data in the new custom field 
7. To test the new field, go to the Tenants screen. 

8. Double click on an existing tenant. The Tenant Details screen displays, with 
the new field, Second Tenant.  

9. Enter data into Second Tenant and click OK. 
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10. The new data is saved against the Tenant.  

  

Displaying new custom field data in the Screen 
11. Click on the Quick customize button in the Tenant grid, and check Second 

Tenant. 

 
12. The value Second Tenant will now display in the Tenant data grid.  You can 

click and drag the column header to move it around.  You can also click and 
drag the right edge to resize the column.  The new size and position will be 
changed when you close RPM. 

13. You can click on the Second Tenant header to sort this column's data, and 
you can search it. 
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Creating Late Fees 
This tutorial describes how to create and charge a late fee. 

A late fee is a charge against a tenant levied as a penalty for a late rental payment.  

As an example, the user will create and charge two types of late fee, charging 
$15.00 for the first late fee and $25.00 for the second late fee. 

Creating the Late Fee 
1. In the Tools menu, click Options. 

2. The Options screen displays. 

3. Select the Default Fees option.  

4. Go to the Late Fees frame and set up the first late fee. In the row for the First 
fee, enter values for the first fee: 

• Type - Once only. 

• Amount - Enter the amount of this fee, $15. 

• Day due - Enter the number of days after the main rental payment is due 
when the late fee is charged. In this example, if the tenant is 3 days late 
paying the rent, they incur the $15 fee. 

5. Go to the Late Fees frame and set up the second late fee. In the row for the 
Second fee, enter values for the second fee: 

• Type - Once only. 

• Amount - Enter the amount of this fee, $25. 

• Day due - Enter the number of days after the main rental payment is due 
when the late fee is charged. In this example, if the tenant is 10 days late 
paying the rent, they incur the $25 fee. 

Click OK. The new Fees are saved and available. 
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6. To charge a Tenant a Late Fee, in the Tenant screen or the Income screen, 
click the Add Monies Due button, to view its menu. The menu now includes 
the late fees. Select Add Late Fee. 

 
7. The Income Details screen displays. Select the Tenant, and the late fee is 

automatically calculated. The tenant below receives both late fees, for being 3 
days late and then 10 days late. Enter the information about the fee, and why 
it is being charged. 

 
8. You can use this screen to generate an invoice for this late fee. To do this, 

click Invoice. 

9. Once you have created and saved the invoice, click OK. 

10. The late fees are recorded against the tenant. 

 
Income Due Details Screen Values 

• Tenant - Select the Tenant who paid the Income. 

• Category - Select the Category of income. 

• For Period - Select the date period that this income will be applied against. 

• Date due - Select the date when the Income was due. 

• Date paid - Enter the date when the Income was received, if this applies. 

• Late amount - This value automatically displays. 

• Late Fee - The amount of late fees due; this value is automatically 
calculated. You can edit this amount, if required. 

• Reference - Enter any reference or late fee charge type. 

• Notes - Enter any notes about the income. 

• Invoice - Click this button to automatically generate a printable or emailable 
Invoice file. 
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Creating Custom Fees 
This tutorial describes how to create and charge a custom fee. 

A custom fee is a charge against a tenant, or another form of property-related 
income. Examples of custom fees are: extra deposits for pets, a charge to pay for a 
credit check, or lawn mowing or other non-standard maintenance fees. You can 
create custom fees and apply them to tenants. 

As an example, the user will create and charge a custom fee of Credit Check, 
charging $45.00 for this. 

 

Creating the Custom Fee 
1.  the Tools menu, click Options. 

2. The Options screen displays. 

3. Select the Default Fees option.  

4. Go to the Custom Fees frame and set up the new fee. Click to add a new row, 
then enter values for: 

• Name - Name of the new custom fee. 

• Category - Category that applies to the new fee. 

• Fee - Amount of the fee. 

 
5. Click OK. The new Fee is saved and available. 

6. To charge a Tenant a Custom Fee, in the Tenant screen or the Income 
screen, click the Add Monies Due button, to view its menu. The menu now 
includes the custom fees, including Credit Check. Select Credit Check. 
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7. The Income Details screen displays, with information about the custom fee 

being charged to the tenant. Enter the information about the fee, and why it 
is being charged. 

 
8. You can use this screen to generate an invoice for this custom fee. To do this, 

click Invoice. 

9. Once you have created and saved the invoice, click OK. 

10. The monies due are recorded against the tenant. 
Income Due Details Screen Values 

• Tenant - Select the Tenant who paid the Income. 

• Category - Select the Category of income. 

• For Period - Select the date period that this income will be applied against. 

• Date due - Select the date when the Income was due. 

• Amount Due - Enter the amount due. 

• Notes - Enter any notes about the income. 

• Invoice - Click this button to automatically generate a printable or emailable 
Invoice file. 
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Pro Rating a First Rent Payment 
This tutorial describes how to set up a pro rated first rental payment. 

You can set up a Tenant so that their first rent payment is pro rated. Pro rating a 
rent payment means that the Tenant only pays for part of a rent period. This can be 
done as a promotion, or to reflect the amount of time a Tenant is in tenancy for that 
first rent period. 

In this example, a rent period is two weeks, but the tenant has moved in on a 
Wednesday. As a result, they are in residence for ten days of a two week rent period, 
and the rent needs to be prorated.  

 

Setting up a tenant with pro rated rent 
1. Go to the Tenants screen. 

2. Click on the Add Tenant button. 

3. The Tenant Details screen displays.  

4. Enter the Tenant Data by typing or selecting the information into each field. If 
a data field is yellow, that data is required for the tenant record. If a data 
field is white, that data is optional. 

5. To set up a pro rated rent period for a tenant, edit the Property values for the 
Tenant Details. You must enter all of the following values, selected in the 
sample screen below: 

• Rent Period - Amount of time for which the tenant pays rent; weekly, 
biweekly, or monthly. 

• Rent - Rent amount. 

• Rent Start Date - Date when the tenant's first rent payment was due. 

• First full rent period - The date when the first full rent period for the 
tenant begins. 

• Pro rate initial rent - Check this box to pro rate the first rent amount 
due. 
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6. When all the data is entered, click OK.  

7. The Tenant data is saved. The Tenant's first rental payment due is pro rated. 
It is calculated based on the rent start date, compared to the first full rent 
period. This displays automatically, in an Income Details screen: 

 
8. You can use this screen to generate an invoice for this first rental payment. 

To do this, click Invoice. 

9. Once you have created and saved the invoice, click OK. 

10. The tenant details display in the main screen. Note that the values for the 
rent due and the standard rent are different.  
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Recording Payments from Multiple Tenants 
This tutorial describes how to record payments received from more than one tenant 
at a time. 

This function is very useful if you have multiple tenants paying rent, by direct deposit 
into a bank account, on the same day. 

In this example, the date is February 6, 2008. The user has checked their bank 
account and seen that two tenants have paid by direct deposit on their due date. 
They both need to be marked as having paid. 

 

Recording payments from multiple tenants 
1. Go to the Tenants screen. 

2. To select multiple tenants, press the Ctrl key on the keyboard while clicking 
tenants with the mouse. Each tenant the user clicks is selected. In this 
example, two Tenants are selected. 

 
2. In the toolbar, go to the Mark as Paid button. From its menu, click on Mark 

Selected as Paid. 

 
3. When prompted, enter the date of the payment. 

4. The selected tenants are marked as Paid. Note that their amount Owing now 
displays as zero. 

`
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Support and Source IT 

Downloading and Installing Updates 
To download and install updates: 

1. Go to the Source IT web site, http://www.sourceitsoftware.com/  

2. Download the latest version of the software. 

3. Install the latest version in the same location as your original version. This 
will update your installation.  

4. You are now ready to use your updated version of RPM. 

 

NOTES: You do not need to uninstall RPM before updating. Nor do you need to re-
enter your registration key. If you need a new registration key, please contact 
support@sourceitsoftware.com 

 

Ordering and Registering 
If you are reading your manual, you might have ordered Rental Property Manager 
already - or you may be ready to go from your evaluation version to a full licensed 
copy with support. 

We have three payment options: 

Register and pay online with our Secure Server (Credit Card only!) 

• Direct your browser to http://www.sourceitsoftware.com/  

• Follow the instructions.  

Via E-mail (Credit Card only!) 

• Send an e-mail to sales@sourceitsofware.com.  Include your name, 
address, credit card type (Visa, master card etc), number and expiry 
date and the application you are purchasing. 

• For extra security, you can send part of the credit card number in your 
main e-mail and the rest in another.  To do this, write your number as 
4545-5555-xxxx-xxxx in the first e-mail and then xxxx-xxxx-2121-
2121 in the second.  

Alternative Payment Methods - If you wish to pay via check or international 
money order, contact sales@sourceitsoftware.com . 

 

 

http://www.sourceitsoftware.com/
http://www.sourceitsoftware.com/
mailto:sales@sourceitsoftware.com
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About Source IT 
Source IT is a small software development shop based in Hastings, New Zealand. We 
specialize in affordable graphic and data solutions for individuals and small 
businesses.  Because we are small, we have a close relationship with users of our 
software products. Our development is driven by user requests and feedback, giving 
users the solutions they want and need. 

Other Source IT products include: 

• Pics Print - Pics Print is a must-have for users with digital cameras and 
images.  It allows you to rapidly output quality prints from the images on 
your computer, digital camera or scanner.  WYSIWYG editing allows you to 
lay out your images on screen exactly as they will appear on paper.  Wizards 
allow you to easily perform common printing tasks, such as creating Posters 
(up to a huge 20x20 pages), greeting cards and thumbnail sheets.  

• M3 Manager - The complete Management and Viewing solution for large 
collections of images and multimedia files.  Smart Pix allows you to quickly 
and easily catalogue and search your files using keywords and descriptions. 
 M3 Manager supports 39 + image formats, v12+ video formats, sound, text, 
PDF, HTML and Office formats.  It offers advanced viewing and file 
management features, as well as file encryption, password protection and 
HTML and e-mail support.  

 

Source IT Technical Support 
Source IT provides support for our customers who purchase our software. 

 

To send an e-mail query for support, log into our web site at 
http://www.sourceitsoftware.com/contact.htm. This page includes a form where you 
can enter your support query. We are a small company and all our tech support 
queries receive direct, personal attention. At the same time, if your query is about 
using the program, we recommend that you check the online help first to see if your 
query can be answered that way. 

 

Contact Source IT care of: 

 

Source IT 

705 Pakowhai Rd 

Hastings  

NEW ZEALAND 

 

http://www.sourceitsoftware.com  

sales@souceitsoftware.com  

support@sourceitsoftware.com  

http://www.sourceitsoftware.com/contact.htm
http://www.sourceitsoftware.com/
mailto:sales@souceitsoftware.com
mailto:support@sourceitsoftware.com
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Rental Property Manager License Details  
1.   Distribution  
This shareware software, Rental Property Manager (RPM) may be freely distributed, 
provided that:  

• Such distribution includes only the original archive supplied by Source IT. 
 You may not alter, delete or add any files in the distribution archive.  

• The distribution does not include a registration number or information on 
disabling the features.  You are also forbidden from distributing registered 
version of RPM. 

• No money is charged to the person receiving the software, beyond reasonable 
cost of packaging and other overhead. The distribution does not include a 
registration number or information on disabling the features.   

You are also forbidden from distributing a registered version of RPM. For further 
information about redistribution of Source IT products e-mail us at 
sales@SourceITsoftware.com.  

 

2.   License  
By receiving and/or using Source IT software products, you accept the following 
Evaluation and Registered User Agreement.  This agreement is a binding legal 
agreement between Source IT and the purchasers, users or evaluators of Source IT's 
software and products. 

 

3.   Evaluation (Unregistered) and Registered User Agreement  
You may evaluate RPM for maximum of thirty calendar days, after which you must 
register the program with Source IT or remove the software from your computer. 
You may allow other users to evaluate copies of the unregistered Shareware.   All 
evaluation users are subject to the terms of this agreement.  

The evaluator/user/buyer/owner is not allowed to attempt to reverse engineer, 
disassemble or decompile Source IT software and products.  

Source IT's name and any logo or graphics file that represents our software may not 
be used in any way to promote products other than our software.  All parts of Source 
IT software and products are copyright protected.  No program, code, part, image, 
video clip, audio sample, text or computer generated sequence of images may be 
copied or used in any way by the user except as intended within the bounds of the 
single user program.  

The evaluator/user/buyer/owner of Source IT software will indemnify, hold harmless, 
and defend Source IT against lawsuits, claims, costs associated with defense or 
accusations that result from the use of Source IT software.  

Source IT is not responsible for any damages whatsoever, including loss of 
information, interruption of business, personal injury and/or any damage or 
consequential damage without limitation, incurred before, during or after the use of 
our products.  Our entire liability, without exception, is limited to the customers' 
reimbursement of the purchase price of the software (maximum being the suggested 
retail price as listed by Source IT) in exchange for the return of the product, all 
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copies, registration papers and manuals, and all materials that constitute a transfer 
of ownership from the customer back to Source IT.  

Each registered copy of Source IT software may be used in only one single location 
by one user.  Use of the software means that you have loaded the program and run 
it or have installed the program onto a computer.  If you install the software onto a 
multi-user platform or network, each and every individual user of the software must 
be registered separately, except only in the case of a multiple user site licence, in 
which case you are limited to the number of users as expressly stated on your 
multiple user site licence contract.  

You may make one copy of the registered software for backup purposes, providing 
you only have one copy installed on one computer being used by one person.   If any 
person other than yourself uses Source IT's software registered in your name, 
regardless of whether it is at the same time or different times, then you are 
considered to be in violation of this agreement.  

The distribution does not include a registration number or information on disabling 
the features.  You are also forbidden from distributing registered versions of Source 
IT software, or of Source IT software documentation. 

The sale of and or distribution of registered copies of this software is strictly 
forbidden.  It is a violation of this agreement to loan, rent, lease, borrow, or transfer 
the use of registered copies of Source IT software products. 
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